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Preface

Welcome to Marvelous Macintosh Games, an incredible collection of
fifteen games representing almost l,500K of fun. I hope you'll have
as much fun playing with it as I had putting it together.

All but one of these games are shareware. If you're not familiar
with the term, shareware is a wonderful form of low-cost software
marketing. Essentially, it is try-before-you-buy software that can be
freely copied (usually with some restrictions). You are encouraged
to give copies of shareware to your friends to try. When you like a
particular piece of shareware enough to continue using it regularly,
you are asked to send the author a few dollars—$5 to $15 each for the
games in this book.

Unless you have a friend with an extensive collection of
shareware, there is always a cost associated with acquiring a
shareware program to try out. You can use a modem and down­
load them from an online service such as CompuServe, America
Online, or GEnie, for between $5.00 and $12.50 an hour, or you
can buy them on disks from your local user group.

All things considered, you could probably find all these games
elsewhere. You might even save a dollar or two. And, since it's
perfectly legal to give your friends copies of shareware programs,
even the ones in this book, you might be wondering if this book is
worth $25. My answer is an unqualified "yes."
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What makes it worth the dough? Well, mostly, you've got me to
filter out the bad games; every game in this collection is a gem. I
played more than two hundred games, many of them horrible,
before deciding on the fifteen included here. That represents an
enormous amount of time you will avoid wasting. I spent months
corresponding electronically via modem with shareware game
fanatics, asking wliich games were their favorites. As a result, this
collection contains only great games—the best of the best. Plus, with
this book you get illustrated documentation with hints, strategies,
and techniques for mastering each game.

So, yes, I think you'll find this book a good value. For less than
$2 each, wliich is about what it would cost to download them from
one of the online services, you'll get to try fifteen excellent new
games, complete with printed documentation.

Please remember: Buying this book does not absolve you of your
responsibility to pay the authors for the games you like. If you like
a game and play it regularly, you're honor-bound to pay for it. The
prices they ask, $5, $8, or $10, are pretty reasonable, considering wha t
ust one commercial game costs. I hope you'll do the right thing.

Paying for our shareware is the only way we can inspire these
authors to continue to write great games. The games in tills collection
took their creators a long time to program and polish; their only
compensation for that work is your shareware payment.

You don't have to decide right away. If you still like a game after
a month or so, chances are it's a winner. At least consider sending the
author a few bucks.

Now, enjoy the games!

Bob LeVitus
Summer 1991

PS: Let me know what you think of Marvelous Macintosh Games.
I can be reached electronically on CompuServe (76004,2076), America
Online (LeVitus), and GEnie (R.LeVitus). Or, if you don't have a
modem, write me care of my publisher (Prima Publishing, P.O. Box
1260BLM, Rocklin, CA 95677).
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System Requirements

First, here's what you'll need to use Marvelous Macintosh Games: a
Macintosh Plus, SE, Portable, Classic, LC, or II series computer; a
hard disk drive; a floppy disk drive; and Macintosh System Software
version 6.0.2 or later. All of the games have been tested using System
7, and appear to work fine with it on most Macs. Note that all System
7 testing was done with 32-bit addressing turned off. If you use 32-
bit addressing and have a problem with one of the games, try it again
with 32-bit addressing turned off.

System 7 users only

If your Mac doesn't support 32-bit addressing, ig­
nore this entire sidebar. To turn off 32-bit addressing,
choose Control Panels from the Apple menu, then
double-click the Memory control panel's icon. If
your Mac supports 32-bit addressing (only the Ilci,
Ilfx, Ilsi, and LC do on the day I wrote this) you'll see
On and Off buttons for 32-bit addressing. Turn it off,
then restart your Mac.
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How to Install the Games

The Marvelous Macintosh Games disk contains almost l,500K of fun.
We've used special compression technology to fit it all on a single
800K floppy disk. So, before you can use the games, you'll have to
decompress them. It's easy. Here's how:

Put the Marvelous Macintosh Games disk in any floppy disk drive.
Double-click the Games Installer icon. Now, using the standard
directory dialog box, locate the hard disk where you want the games
installed and then click the Extract button. (See Figure 1.)

<=□ Cruella
Select Destination Folder:

Figure 1. Installing Marvelous Macintosh Games:
Use the standard directory dialog box to select a hard disk on which to install
the games, in this case, Cruella.

A screen showing the progress of the installer will appear.
When it gets to 100 percent, there will be a folder entitled
"Marvelous Macintosh Games Folder" on your hard disk. The
process will take about ten minutes or less, depending on the kind
of Mac you have.

All of the games are now in the "Marvelous Macintosh Games
Folder." Each is described in its own chapter; follow the specific
directions for each game.

And now, a word about our special compression technology:
This program is being distributed in a Compact Pro (formerly called 
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Compactor) archive. Compact Pro is a file compression utility by Bill
Goodman. If you're interested in obtaining a copy, it's available on
most online sendees or BBSs, and from most Macintosh user groups.
Or you can order a copy directly from the author for $35. (Write to:
Bill Goodman, 109 Davis Avenue, Brookline, MA 02146. Massachu­
setts residents add 5 percent sales tax. VISA, MasterCard, check, or
money order is acceptable. Checks and money orders must be
drawn on a U.S. bank in U.S. dollars.)

If a Game Crashes

Some games may conflict with other programs you use. In particu­
lar, it's possible that some games may conflict with other inits and
cdevs you already have running on your Macintosh. If a game
crashes on you, try removing any inits or cdevs from your System
Folder that might conflict with the games. (Inits and cdevs, by the
way, are called Extensions and Control Panels, respectively, under
System 7.)

Under System 6

You can identify inits (Startup documents) and cdevs
(Control Panel documents) by first opening the Sys­
tem Folder and then choosing By Kind from the
View menu.

Look under the Kind column for Control Panel
documents and Startup documents. There are sev­
eral that are standard to the Macintosh that you need
to keep, such as Mouse and Keyboard. Only remove
anything that looks unusual—probably the ones
you added yourself. DO NOT throw these unusual
items in the Trash; just drag them out of the System
Folder and put them somewhere else on your hard
disk. Then restart your Mac.
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Under System 7

Inits will be found in the Extensions folder and cdevs
in the Control Panels folder, both of which can be
found iii your System Folder.

There are several that are standard to the Macin­
tosh that you need to keep, such as Mouse, General
Controls, File Sharing Extension, Keyboard, and a
few others. Only remove any tiling that looks un­
usual—probably the ones you added yourself. DO
NOT throw these unusual items in the Trash; just
drag them out of the System Folder and put them
somewhere else on your hard disk.

Or, you can disable all of your inits and cdevs
(Extensions and Control Panels) by restarting your
Mac and holding down the Shift key until the desk­
top appears.

By the way, under any version of the System, you can later return
the inits and cdevs you removed to your System Folder. Just drag one
of the previously removed inits or cdevs into the System Folder and
then choose Restart from the Special menu. If you are now able to
play the game in question, repeat the process with another init or
cdev. Keep doing this until you find the culprit.

It is possible that one or more of the games will not run on your
particular system. There was no way for us to test every combination
of Macintosh model and System software version. If a game doesn't
work on your machine, I apologize profusely. If you do run into a
problem with a game, I recommend you contact the author of the
game directly. Most of the games come with documenta tion or built-
in help that will tell you how to get in touch with the author.
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Disclaimer

I make no claims about the performance of the games on the
Marvelous Macintosh Games disk. I, along with my team of beta
testers, played the games on a variety of Macs, using several versions
of the System software. They seem to work as advertised in our
(albeit limited) testing. I feel relatively certain that they are not going
to do any damage to your Mac (like trash your hard disk or bum up
your motherboard). However, I make no guarantees—use them at
your own risk.

I'm a firm believer in backing up your hard disk. I strongly
recommend that you have a complete backup available before you
try these games. If you don't have one, I suggest you create one now,
just in case.

Some games may conflict with other programs you use, espe­
cially inits and cdevs. There was no way I could test every possible
combination of hardware and software. I apologize if something
doesn't work on your particular setup, but I cannot be held respon­
sible.
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Columns
Simple to learn, difficult to master, and extremely
addicting, Columns is reminiscent of world-famous
Tetris.

Tetris is one of the most popular computer games in the world,
available for the Mac, PC, Nintendo, and even in a coin-operated
arcade version. Chances are you've played it at some time in your
life. And if you like Tetris, you're going to love Columns. In
Columns, the idea is to manipulate falling tiles to form sequences of
three-in-a-row. Easy to learn, difficult to master, and extremely
addicting, you'll find yourself playing it over and over again.

Playing Columns

In Columns, the object is to manipulate the falling tiles to form
sequences of three or more boxes of the same pattern. Tiles are made
up of three boxes; each box is assigned one of six patterns at random.
The sequences you're trying to form can run vertically, horizontally,
or diagonally. When a sequence of three or more boxes of the same
pattern is achieved, those boxes disappear from the screen and you
are awarded points. (See Figure 2.)

To begin playing Columns, double-click its icon. When the game
opens, a new game will start automatically. Tiles drop one at a time
from the top of the playing area. You can manipulate them from the
keyboard or numeric keypad (see Figure 3).
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=r~]^= Columns

Figure 2. Columns:
When the tile in play drops, the three horizontal gray boxes will disappear and

one point will be scored.

Tile in play

Drop

Left

j i
Cy cle Right

K I L :

space ....

Keyboard
Controls

Drop

(Numeric Key Pad)

Figure 3. Keyboard Controls:
You can use the keyboard or numeric keypad to control the action.
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° Move the tile to the left one position (using the J key
on the keyboard or the 4 key on the numeric keypad).

° Move the tile to the right one position (using the L key
on the keyboard or the 6 key on the numeric keypad).

° Cycle the patterns of the boxes in the tile so that each
pattern moves down one box, with the top box in the
tile assuming the pattern of the bottom box (using the
K key on the keyboard or the 5 key on the numeric
keypad).

° Drop the tile straight down into place (using the
spacebar on the keyboard or the 2 key on the numeric
keypad).

Try them out—it's easy once you get the hang of it. Each time you
press the cycle key each pattern moves down one box, and the
bottom box moves to the top. (See Figure 4.)

1
Press cycle key 0 12 3 times

Figure 4. Cycling:
The same tile as it appears when you press the cycle key one, two, and three
times.

OK, now that you've got the hang of the controls, you're ready
to play a game. Choose New Game (Command-N) from the File
menu.

The object of the game is to arrange the tiles on the game board
so that boxes of the same pattern line up in three (or more) box
sequences diagonally, horizontally, or vertically.

Any time a three (or more) box sequence is created, those boxes
are removed from the board and all boxes located above them drop
to occupy the vacated spaces. New three box sequences can be
formed by the "chain reaction" that occurs as a result of boxes
dropping to fill in squares vacated by other boxes; these new
sequences will also be removed from the board.
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Each three box sequence you remove is worth one point. It's
possible to place a tile so a sequence of more than three boxes is
formed, hi this case, you get a point for the three box sequence, plus
an extra point for each additional box. So a four box sequence would
be worth two points, and a five box sequence worth three. It is also
possible that the formation of a three box sequence, when it is
removed, will create another three box sequence (which is also
removed). In this case you receive one point for each individual three
box sequence.

The game ends when any box touches the ceiling line at the top
of the game board.

To view Columns' built-in help, choose About Columns from
the Apple menu.

Mastering Columns

Here's the most important tip: Don't act hastily. Use the Drop key
paringly, especially at first, and be absolutely sure before you do use
t. You don't get any extra points for using it, and you often drop the

perfect piece onto the wrong column. Think about it first, and only
use the Drop key when you're absolutely certain you've found the
perfect place for the tile.

Columns is a game where strategy counts. Think ahead several
moves. And don't only look for the obvious vertical and horizontal
sequences. Diagonal sequences are frequently more effective, as
they often create more new opportunities than either horizontal or
vertical sequences.

Try to avoid dropping a tile so a single box lands on top of
another single box. You'll end up with two boxes of the same pattern
and two nonmatching boxes atop them. (See Figure 5.) Vertical pairs
are difficult to remove, especially when there are other boxes above
them. Try to drop the tile one or two spaces away to create the
potential for a diagonal or horizontal sequence.

There are always several moves available. Some are always
better than others, and one is often best. Think it through—what
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Figure 5. Bad, Better, Best:
The middle move is better because it leaves three potential diagonal se­
quences; the right move is best because it scores two points (for the four box
sequence).

appears to be a good move might not be the best move. And always
try to think forward a couple of moves. A good move either scores
points or sets you up to score points soon.

Columns: The Fine Print

"I wish to thank Jay Geertsen, who wrote the original Columns game on
which this version is based. Thanks also to the many Columns addicts that
have written me already. (I still have not received any letters from Africa or
Antarctica.) I am constantly amazed at how many people have enjoyed this
simple game. Ihave already started working on ‘Son of Columns' and would
love to hear your requests for enhancements.''

Chris Christensen

Columns is shareware. If you enjoy playing it, please send $5 to
Chris Christensen, 6901 Chiala Lane, San Jose, CA 95129.





Continuum
This challenging, fast-paced, arcade-style space
game places you at the controls of a highly maneu­
verable space ship flying across increasingly dan­
gerous planets.

Continuum is one of the finest, most exciting, and challenging
arcade-style space games around. And with sixty planets to con­
quer, and a planet editor so you can create your own, you'll never
grow tired of playing. The object is to maneuver your space ship
across each planet, killing off bad guys, avoiding walls, and finding
fuel as you go. Killing all the baddies on a planet scores a bonus and
advances you to another, more difficult planet. You'll need fast
reflexes and a steady hand, but once you get the hang of it, you'll find
it dam near impossible to quit playing.

Playing Continuum

The object of Continuum is to destroy all the enemies on a planet as
fast as you can. Do it fast enough and you'll receive a bonus. Keep an
eye on your fuel level; it's possible to run out and find your ship
marooned. Once you've destroyed all the enemies on the planet,
you'll (perhaps) receive a bonus, then be sent on another mission on
a different planet.

To begin playing Continuum, open the Continuum folder, then
double-click the Continuum icon. (If you have a color Macintosh, the
game will run significantly faster if you switch to black-and-white
mode before starting the game.) The game will launch and you'll see
the high score screen.
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If Continuum gives you an error message
when you launch it...

Try disabling any inits or cdevs, and turning off youi
RAM cache. (It's in the General Control Panel if you
use System 6, and in the Memory Control Panel if
you use System 7.) Some users have reported diffi­
culty running Continuum under MultiFinder on
older Macs using System software versions earlier
than System 7.0. If you are having a problem, try this:
First disable any inits or cdevs and turn off your
RAM cache, then restart under Finder instead of
MultiFinder. You may find it easier to restart using
the Apple-supplied System Tools disk as your startup
disk. Also, Continuum appears not to work at all
with the Mac LC.

Your ship is controlled by the keyboard. (See Figure 6.) The
default keys are thoughtfully placed and convenient for fast re­
sponse. Although you can change them by choosing Set Controls in
the Game menu, I suggest leaving them alone, at least until you've
gotten somewhat proficient.

Turn Left Turn Right
z H

Shield
space

Thrust Fire
, /

Figure 6. Keyboard Controls:
These are the default keyboard controls; you can change them using the Set
Controls command in the Game menu.



Continuum

Now that you know how to control your ship, choose Start Game
(Command-S) from the Game menu. Your ship appears at the
bottom of the screen. (See Figure 7.) Tap the thrust key (.) a couple of
times to move your ship into the playing area. Now rotate to the left
(Z) so you're pointing at the enemy space station. Fire a few bullets
(/). Finally, test out your shield (spacebar).

Figure 7. Continuum—Planet 1:
The object is to avoid walls and bullets, kill all the enemies, and not run out of
fuel.

Next, let's acquire some additional fuel. Rotate to the right (X),
and use the thrust key to move your ship on top of the fuel depot.
When your ship is touching it (or almost touching it), activate your
shield. You'll hear three beeps if you've succeeded, and the fuel
depot will turn white.

Now, just fly around killing off bad guys, which are worth
between 10 and 500 points. (See Figure 8.). If you manage to kill them
all quickly enough, you'll receive a bonus before being transported
to the next planet.
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100 400 500

10 200 300
Figure 8. Scoring:
Enemies are worth between 10 and 500 points.

Keep an eye on your fuel. You'll receive a warning if the fuel level
gets low, but if you run out, your ship will be marooned and you'll
have to abandon it (Command-A).

You may pause the game at any time by pressing Caps Lock.
Another way to pause is to invoke the map feature by pressing the
M key. The game will pause, allowing you time to peruse the planet
map. Fuel depots are blinking squares, remaining enemies are solid
dots, enemies you've killed already do not appear. To resume your
game, press any key.

There are two other commands that make learning Continuum
a bit easier. First, if you find a planet too hard or too boring, you can
abort your mission and go immediately to the next planet by
pressing Command-U. Second, you can acquire extra ships by
pressing Command-E. Both of these commands are useful while
you're learning the game, but if you use them, you'll be disqualified
from recording a high score.

Once you've gotten proficient at playing, you might want to try
your hand at building your own planets. If so, be sure to read the
"Planet Editor Docs" in the Continuum folder. (Double-clicking it
will launch TeachText if it's somewhere on your hard disk. If
TeachText isn't available, use the Open command in your word
processor.)
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That's all there is to it. At least, that's all there is to controlling
your ship. Mastering it is another story.

To view Continuum's built-in help, choose the appropriate
category (Instructions, Scoring, Tips, or Demo) from the Game menu.

Mastering Continuum

When you're first learning, don't be afraid to request Extra Ships
(Command-E). Although you won't get your name on the high score
list, you will learn the game much faster.

When you start out on each planet, check the planet map (press
the M key). (See Figure 9.) Not only does this give you an overview
of the planet, but it also pauses the game. You can also use the map
after you've ventured out into the planet to discover where the
remaining enemies and fuel are located. There is no penalty for using
it, so look at your map as often as you like.

Some planets (i.e., planets 2,4,5, and many others) have "wind,"
which makes maneuvering your ship much harder. When you're
first learning the game, try sticking to levels 1 and 3, which don't
have any wind to distract you.

There are three kinds of walls in Continuum: normal, bouncing
(ships and bullets bounce off), and phantom (does absolutely noth­
ing; it's just there to confuse you). They all look similar on the screen,
so the best strategy is to assume that every wall will kill you if you
touch it.

Be aware of your fuel. Thrust and shield use fuel at a rapid rate,
so try to use both sparingly. I find that tapping the thrust key works
better than holding it down for an extended period of time. If you see
the Fuel Critical alert, which appears in the upper left-hand comer
of the screen when you have less than 2,000 units of fuel left, it's a
good idea to press the M key immediately and find a fuel depot. If
you do run out of fuel, your ship is considered marooned and the
game will stop until you abandon it (Command-A).
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Figure 9. Use Your Map:
Solid circles are enemies; flashing squares are fuel.

Another fuel-related tip: Don't use all the fuel depots on any
planet for a single ship. If that ship is destroyed, so is its fuel.
Remember, your next ship may very well need that fuel, so only
refuel when you think it's necessary.

At higher levels you'll need to use your shield a lot. Don't be
afraid to; that7s what it's there for. Though it won't save you if you
hit a wall, at higher levels there can be lots of enemy bullets (and, on
some planets, ricochets from your own bullets). The shield defends
you against them. But be careful—using the shield consumes fuel at
about the same rate as thrusting. So, if you plan to use the shield a lot,
make sure you refuel often, too.
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Don't give up! This game isn't as easy to leant as some, but once
you get the hang of it, you'll find it extremely challenging. For
inspiration, try choosing Demo from the Game menu. You'll see
what a game looks like when played by an experienced player. Stick
with it, and you'll soon be zooming around like an expert, too!

Continuum: The Fine Print

"In creating Continuum, we concentrated on the play and feel of the game.
We wanted to make the controls so natural and smooth that the ship felt like
an extension of your will. We hope you enjoy the results."

Randy Wilson

Continuum is beerware. You may copy it freely and give it to
anyone, as long as it is not modified or sold. If you enjoy playing it,
please send a case of fine beer to Randy Wilson, 82D Escondido
Village, Stanford, CA 94305. Should your age prevent your legally
tendering the above registration fee, other items of commerce—such
as money, promises of firstborn, or footrubs administered with
suitably exotic oils—will be accepted.





Darts
Like having an English pub inside your Mac, Darts
faithfully reproduces the age-old game for which it is
named.

Darts delivers the excitement and enjoyment of a rousing game of
darts without the inconvenience of seeking an opponent or a pub.
This faithful re-creation offers you a choice of dart games for one or
two players. If you like the real thing, you're going to love Darts.

Playing Darts

Darts is a faithful re-creation of the dart throwing game played in
pubs and basements from time immemorial. Like real darts, you'll
be inept at first, but with practice you'll soon be throwing bull's-eyes
at will.

To start a game of Darts, double-click its icon. The game selector
screen will appear. (See Figure 10.)

Type your name in as Player 1. If you type nothing into the Player
2 field, you'll play alone; if you type in another name, you'll play in
the two player mode. For now, just click the OK button.

Above your name (Player 1 in Figure 11) you'll see three small
circles. These represent the number of darts remaining in your turn;
a turn consists of three darts.

To throw a dart, click anywhere in the white areas to the left or
right of the board, and drag toward the dart board. When you release
the mouse, the dart will be launched in that direction. The length and
angle of your drag determine where the dart will land.
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Figure 10. Choose Game:
Darts includes several variations on the '01 game (301, 501, or 1001), as well
as Round the Clock, and two flavors of Cricket.

Darts remaining

1) Click here

2) Drag to here and release

Figure 11. Throwing Darts:
Click and drag as shown, and you'll land your dart close to the bulls-eye.

Go ahead and try it now. Chances are you'll miss the board
completely. That's OK. Take a look at Figure 11. Try to imitate the
click and drag shown. It should land your dart close to the bull's-eye.

Practice makes perfect; don t give up. It takes a while to get the
hang of it, but once you've gotten a feel for the system, you can be
almost as accurate as if you were throwing real darts.
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Darts provides a choice of several games—three variations on
the '01 game (301,501, or 1001), as well as Round the Clock, and two
flavors of Cricket. Finally, you can choose the Double In And Double
Out option, which makes any game a bit tougher.

Tire '01 games are the traditional form of dart game. Your throws
are deducted from the starting total (301, 501, or 1001). Tire inner
bull's-eye is worth 50 points, the outer bull's-eye is worth 25. Darts
in any other sector score according to the sector number with two
exceptions: Darts in the outer ring score double the sector number,
and darts in the inner ring score triple the sector number. (See Figure
12.)

Sector Number

Inner Ring (Triple) Outer Ring (Double)

Figure 12. Scoring Darts:
The inner ring scores triple, the outer ring scores double, and all other areas on
the board score the sector number.

To finish the game, your score must reach zero. (See Figure 13.)
If your score takes you past zero, the score reverts to its level before
that turn began, and you forfeit any remaining darts.
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(Game) 301
(Preu) -22

279
(This Turn) -16

263

-*— Game Total 
-<— Previous Total 

-*—Total This Turn

needed to win

Figure 13. Scoring 301:
Your score for each turn is deducted from the game total; you need exactly

zero to win.

In Round the Clock, each player must throw one dart into each
sector in order, from one to twenty. Darts landing in sectors other
than the next one wanted are not scored. (See Figure 14.)

R CHECK INDICATES THOSE
SECTORS ALREADY HIT. THE FIRST
NUMBER DOWN THE LIST WITHOUT
A CHECK IS WHAT YOU NEED .

Figure 14. Scoring Round the Clock:
The object is to throw a dart into each sector in order; sectors you've already hit
are checked.

Cricket is a little tougher. You must land three darts in each of the
following sectors: 20,19,18,17,16,15, and bull's-eye. Darts within
a sector score a point unless they are in the outer (double) ring or
inner (triple) ring. Darts in the rings score two and three points
respectively. The inner bull's-eye scores two points, and the outer
bull's-eye scores one point. You can choose to play this game ''in
order" (i.e., 20, then 19, then 18, etc.), or in any order. Tire number of
times you've hit a sector is indicated by a single line (once), an X
(twice), and an X in a circle (three times). (See Figure 15.)
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3 POINTS

2 POINTS

1 POINT

Figure 15. Scoring Cricket:
The number of times you’ve hit a sector is indicated by a line, an X, and an X in
a circle.

Last but not least, if you choose the Double In And Double Out
option in the game selector window, your first and last throws in
each game must land in the outer (double) ring in order to coimt. If
they land anywhere else, they are ignored.

To view Darts' built-in help, choose About Darts from the Apple
menu.

Mastering Darts

There's not much I can tell you about mastering this one, except that
practice makes perfect. At first it seems awkward, and you'll find a
lot of your darts miss the board. Stick with it. With a little practice,
you'll soon be landing your darts wherever you aim them.
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Darts: The Fine Print

"If you happen to like/use this program, please send me an incentive to
improve it and develop others. Only your reward for my time and effort will
give me the incentive to keep going. It will also be greatly appreciated."

Bob Boylan

Bob Boylan, 54 Howe Road, Coram, NY 11727.



Dropper
Another challenging and highly addictive game
reminiscent of Tetris, Dropper is particularly beauti­
ful in color.

Dropper is similar to Columns, with several interesting twists. The
object, once again, is to maneuver blocks that drop from the top of the
window into vertical, horizontal, or diagonal lines. But instead of
one continuous game, Dropper is a series of levels and stages, each
more challenging than the one before. And unlike Columns, bonus
points are awarded for completing horizontal, diagonal, or multiple
lines. Best of all, Dropper runs in glorious color on Macs so equipped

Playing Dropper

In Dropper, cubes that have one of seven different patterns (colors
on color Macs) drop from the top of the window. Your goal is to stack
or line them up vertically, horizontally, or diagonally. Horizontal
and diagonal lines are worth more points than vertical stacks.

When you line up the correct number—four, five, or six, depend­
ing on the level you're at—the cubes vanish and your score in­
creases. (See Figure 16.)
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Figure 16. Dropper:
When this cube drops, a diagonal line of four (lower right to upper left) will be
formed, those four cubes will disappear, and all other cubes will drop down to fill
the empty spaces.

To begin playing Dropper, double-click its icon. The dropping
cubes are controlled from the keyboard. (See Figure 17.) The default
keys are set to J for left movement, L for right movement, and
spacebar to drop the cube. You can change them by choosing Set
Keys from the Game menu, if you like. To do so, type in the keys you
want to use, and click the OK button. To revert to the default keys,
click the Standard button.

To start a game, choose Start Game (Command-G) from the
Game menu. When the game starts, maneuver the cubes into
position using the keyboard controls. The first three levels consist of
a playing field four cubes wide, and the object is to remove four cube
sequences. Each removal is called a "drop," and you must achieve
eight of them to complete the first level. The number of drops you
need to complete a level can always be seen on the left side of the
screen.
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Figure 17. Keyboard Controls:
These are the default keyboard controls; you can change them using the Set
Keys command in the Game menu.

Moue left

Dropper Keys

Drop Moue right

<space> L

r H

OK
____________________________r)

I- ■>

Cancel
—

r S

Standard

The game is a series of levels and stages. The sequence is as
follows:

Level Stage Cubes Wide Drops
1 1 4 8
2 2 4 11
3 3 4 14
4 1 5 17
5 2 5 20
6 3 5 23
7 1 6 26
8 2 6 29
9 3 6 32

The number of drops required increases at higher levels, and
liigher numbered levels and stages play faster.

Points are scored whenever you create a sequence (a drop).
Whenever a sequence is created, those cubes are removed from the
board and all cubes above them drop to occupy the vacated spaces.
New sequences may be formed by the chain reaction that occurs as
a result of boxes dropping to fill in squares vacated by other boxes;
you receive a bonus when this occurs. Bonuses are also awarded at
the end of each level for horizontal and diagonal lines. Vertical 
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sequences score points, but no bonus. At levels ten and beyond, there
will be some cubes in place when you start the level, hr general, the
higher the stage and level, the more points everything is worth.

The pause button allows you some thinking time. You can press
the movement keys while you're clicking on the pause button to
guide the current cube. You won't see it move until you release the
pause button, though. There is no penalty for using it, but there is
only so much pause time allowed. Tire pause time remaining can be
seen on the left side of the screen.

Finally, there is a Preview option available in the Game menu
that lets you see the next cube before it appears at the top of the
screen. (See Figure 18.) Be warned: Preview carries a substantial
penalty; if you use it, your score for that stage will be halved. If you
turn it off before starting the next stage, you'll receive the full score
for that stage.

To view Dropper's built-in help, choose Help from the Apple
menu.

Figure 18. Preview:
The Preview option shows you what the next cube will be, but causes your
score for that stage to be halved.
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Mastering Dropper

Although horizontaland diagonalsequences score bonuses, they're
harder to achieve. And while the bonuses increase as you reach
higher levels, they also become harder to achieve. You'll probably
be able to play longer and reach higher levels if you concentrate on
completing vertical stacks, but your score won't be as high.

Always try to stack a pattern on a like pattern. If you have too
many nonmatching cubes stacked on one another, that column
becomes almost impossible to clear out. One strategy that seems to
work is to use one stack as a catchall, and concentrate on making
vertical sequences in the other three stacks. That way you can
usually avoid having to put a nonmatching cube on top of three,
four, or five of a kind. Use the catchall stack to ditch nonmatching
cubes.

There is one pattern (it appears as a solid black cube if you'i
playing on a color machine) that rarely comes up. (See Figure 19.,
Avoid trying to make a sequence that uses this pattern; on most
levels you won't see enough of them to complete a sequence.
There's nothing special about this kind of cube. You don't get a
bonus for creating a sequence with them. So, always place them
where they'll cause the least disruption to your game.

Figure 19. Rare Pattern:
Avoid trying to make sequences with cubes that look like this (or solid black

cubes on color machines).
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Dropper: The Fine Print

"Take a break for ten minutes, play again. Nothing epic, nothing compli­
cated. Just relax and watch the colors."

C. K. Haun

Dropper is shareware. If you enjoy playing it, please send $5 in
cash (no checks, please) to C. K. Haun, RavenWare Software/Mac
Division, 22045 McClellan Road, Cupertino, CA 95014.



Flipft
Deceptively simple, with only one rule to learn, Fliplt
demands intense concentration and the ability to
think ahead.

Fliplt is a simple board-style game that pits you against either the
computer or another human player. The board consists of sixty-four
squares; the object is to place your stones so that you own more
squares than your opponent when the board is completely covered
with stones. Though easy to learn, Fliplt is stimulating every time
you play. And if you're anything like me, you'll play again and
again.

Playing Fliplt

The object of Fliplt is to have more stones than your opponent when
the board is completely filled. Play alternates between you and the
computer, or you and another human opponent. Each player places
one stone per turn. A stone can only be placed on a square where
your opponent's stones are lined up in the middle, so that your
stones will be on both ends. The opponent's stones are then "flipped"
to your color. Lines can be vertical, horizontal, or diagonal. (See
Figure 20.)
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Figure 20. Fliplt:
(Top) The board as it appears when you start a new game. I've indicated all
your possible moves (you’re white) with an X. (Bottom) The result of making
one of the moves—the black stone you’ve surrounded is “flipped."
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To begin playing Fliplt, double-click its icon. When the game
opens, a new game will start automatically, with you playing white
and the computer playing black. You take turns placing stones by
clicking on a valid square. Fliplt knows which moves are valid; if you
try to place a stone on an ineligible square, your Mac will beep at you.

Play continues until the board is filled. Whoever has the most
stones at that time wins. That's all there is to it!

There are several options available in the Options menu (see
Figure 21).

Options
Pass
Hint

■/Computer
Human

/White
Black

/Beginner
Intermediate
Aduanced

Figure 21. Fliplt Options:
You can alter the way Fliplt plays using choices in the Options menu.

° As the game progresses, it's possible that you'll have a
turn where no valid moves are available to you. When
this occurs, you must choose Pass from the Options
menu. You'll lose a turn, and then play will continue.

• You can receive a hint at any time by choosing Hint
(Command-H). There's no penalty for doing so, and
it's particularly useful when you're first learning the
game.
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• You can choose to play against the computer or
another human. The default is computer; you'll play
against your Mac unless you choose Human from the
Options menu.

• You can choose to play white or black stones. The
default is White; you'll be the white player unless you
choose Black from the Options menu.

• There are three levels of play: beginner, intermediate,
and advanced. The default is Beginner; choose Inter­
mediate or Advanced when you start winning consis­
tently at the beginner level.

Fliplt is easier to play than it is to describe. Play once or twice and
you'll see. Although it's a simple game, it's not easy to win. You need
a keen, analytical mind to win regularly, especially at the advanced
level.

Mastering Fliplt

The most important hint, if you want to master Fliplt, is to get the
comer spaces. Once you've got a comer, it's impossible for your
opponent to flip that stone (and any stones you place adjacent to it
on the edges of the board). In order to get those comer spaces for
yourself, you must make sure your opponent doesn't get them.

The squares adjacent to the comers are also important, especially
when you own the comer. Once you control these squares—as long
as the/re adjacent to a corner you own—your opponent can't flip
them.

The squares along the edges of the board are good, but unless all
the stones between there and a comer are yours, it's possible for you r
opponent to flip them.

Strategy is everything in Fliplt. Always consider your moves
carefully. Fliplt has no Undo feature, so if you click a square, even
briefly, you're committed to that move. Another reason to consider
your moves carefully is that the best move is not always the one tha t 
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gains you the most squares right now. If a move gains you a few
squares but leaves your opponent an opportunity to flip a lot of
your stones on the next move, it's not a good move. Think ahead!

Don't get frustrated if you seem to be losing mid-game. Tides
turn quickly in Fliplt. You could easily surge ahead with one or two
moves. But don't forget that it works both ways. Even when you
appear to be winning, one or two good moves by your opponent can
leave you in the dust.

Fliplt: The Fine Print

"This program is dedicated to my brother Greg. It was his idea to develop a
game that was both fun and challenging, but would not take a long time to
play. (I believe he wanted something he could play at work, but don't tell his
boss!)

I hope everyone else will enjoy Fliplt as much as we have and would
appreciate any comments you have."

Kevin Clark

Fliplt is shareware. If you like it, please send $5 to Kevin Clark,
P.O. Box 5114, Woodridge, IL 60517. If you would like a copy of the
source code written in Think C, send $20.





Flipper
A fast-moving game of timing, thought, and quick
reflexes.

Flipper is a fast-moving game where reflexes and timing mean
everything. Written by the creator of Dropper, C. K. Haun, Flipper
runs in beautiful color on Macs so equipped, but is equally challeng­
ing m black-and-white. Flipper is laughably simple at its earlier
levels, but watch out—it gets progressively harder until it's almost
impossible to continue play.

Playing Flipper

In Flipper, the object is to make all the rectangles the same pattern (or
color, on Macs so equipped). You change the color of a rectangle by
clicking on it. When all the rectangles are the same (see Figure 22),
you move on to a new (and harder) level.

To begin playing Flipper, double-click its icon. Choose Start
Game (Command-G) from the Game menu. There are no controls
used other than the mouse. Just click to change the pattern (or color)
of a rectangle. When all the rectangles are the same, the level is
complete.

Sound easy? It is, at least at first. But Flipper gets tougher as you
get to higher levels. First of all, Flipper will flip the rectangles to the
next pattern in the progression at random times. Second, it gets
harder as you complete more levels since there are more spaces on
the grid and more colors or patterns in the progressions—as many
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Figure 22. Level Complete:
To complete a level, all the rectangles must be the same pattern (or color, on
color-equipped Macs).

as thirty at the higher levels! Third, the time Flipper waits before
changing patterns or colors gets shorter as the levels increase. And
fourth, Flipper only allows you 300 seconds—that's five minutes—
to complete each level.

Sounds unfair, doesn't it? Don't despair; Flipper provides you
with some weapons of your own. Tire first is the "freeze." You can
freeze the current pattern or color of a rectangle by holding down the
Option key as you click it. The border of that rectangle will flash to
show you it's frozen. (See Figure 23.) When a rectangle is frozen,
Flipper can't change its color or pattern; but neither can you, so be
sure if s the pattern you desire before you freeze it.

You unfreeze a rectangle the same way, by clicking it while
holding down the Option key. Try not to waste valuable freezes,
though—you have a limited number available! The number of
freezes remaining is always shown at the bottom of the Flipper
window. You gain four freezes for each level you complete, but there
is a penalty of twenty points for each freeze you use.
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Frozen Rectangles
(borders Hash gray)

Figure 23. Frozen Rectangles:
Frozen rectangles flash to indicate they’re frozen.

You also have the option of using the Progression box, which
will appear at the bottom of the window when you choose See
Progression from the Game menu. (See Figure 24.) While the See
Progression option can be helpful, you'll be penalized half of your
score for each level you use it on. This happens if you use See
Progression at any time during the level, so if you don't want to be
penalized for a level, make sure this option is turned off before the
level starts.

Points are scored based on the time it took you to complete the
level. This is multiplied by the level number. Penalties are deducted
from your score.

To view Flipper's built-in help, choose Help from the Apple 
menu.
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Flipper

Progression

Figure 24. See Progression:
Choosing See Progression from the Game menu displays the order of patterns
or colors for the current level.

Mastering Flipper

First and foremost, make sure your fingers, especially the one you
click the button on the mouse with, are in good shape. No game in
this collection is harder on your fingers.

Try to memorize the progression without using the See Progres­
sion option. Because Flipper always flips rectangles to the next
pattern or color, this can be extremely useful. One excellent strategy
is to change rectangles to the pattern or color that comes before the one
you desire. Then, when Flipper starts flipping rectangles, it's flip­
ping them to your chosen pattern. And you can quickly change these
rectangles to your chosen pattern with a single click.

In early levels, when all but one rectangle match, click like crazy
on the odd rectangle. You can't go too far if you're clicking on the last
remaining odd rectangle, so when you get to the matching pattern,
you'll move on to the next level. It's much harder to use this trick at
the higher levels.
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Finally, use your freezes sparingly, especially in the earlier
levels. I try to go as long as possible without using any. There are two
reasons for this. First, you're penalized twenty points for each one
you use. Second, and more important, you'll really need them more
when you get to the higher levels, where the action is more intense.

Flipper: The Fine Print

"Take a break for ten minutes; play again. Nothing epic, nothing compli­
cated. Just relax and watch the colors."

C. K. Haun

Flipper is shareware. If you enjoy playing it, please send S5 in
cash (no checks, please) to C.K. Haun, RavenWare Software/Mac
Division, 22045 McClellan Road, Cupertino, CA 95014.
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Glider
Glider gets under your skin like salty snacks—bet
you can’t play just one.

Glider is a classic "easy to play, difficult to master" arcade game. The
object is to fly your paper glider across fifteen fiendishly designed
rooms, negotiating an assortment of obstacles. Once you get the
hang of it, you'll play over and over again.

Playing Glider

The object of Glider is to fly a paper airplane you control through a
series of rooms, navigating your way past air ducts, tables, vents,
candles, wall outlets, and more. Some are good; some cause your
immediate demise. The game ends when you've crashed all of your
gliders. (See Figure 25.)

To begin playing Glider, double-click its icon. You move your
glider left and right using the comma (left) and period (right) keys.
If you would prefer to use different keys, choose Controls from the
Options menu and type in your choice of keys. (See Figure 26.)
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Figure 25. Glider in Trouble:
Gravity will cause this glider to crash into the table.

Key to moue glider left

Key to moue glider right

I Okay J

Figure 26. Keyboard Controls:
You can change the default keys (shown) by choosing Controls from the
Options menu.

Other choices in the Options menu include your choice of a
glider or a dart, the dart being the more streamlined and aerody­
namic paper aircraft. You can select the number of gliders you start
the game with by choosing Number of Gliders. Fast or Slow control
the speed of the game, and you can turn the sound on and off by
choosing Sound On.
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Before you start your first game, choose Number of Gliders from
the Options menu and type in 6. The default is 4, but your game will
last longer with 6.

Now you're ready to glide. Choose Begin Game (Command-B)
from the Game menu. Use the comma and period keys to maneuver
the glider left and right. You begin each room at the left side; your
mission is to fly across it, and emerge on the right side. There are
several rules of physics associated with flying your glider:

° Rule of Physics #1: Paper airplanes have no engines
and consequently have a fondness for the carpet.

° Rule of Physics #2: Floor vents (when blowing) easily
lift paper airplanes.

° Rule of Physics #3: Lit candles bum paper.
© Rule of Physics #4: Paper doesn't conduct electricity

well.
° Rule of the author #1: Electrical outlets bum your

glider.

The object is to avoid objects like tables, shelves, and candles,
while using the updrafts from vents to get your glider through each
room. You can get extra gliders and points by flying your glider next
to certain objects; other objects are bad, and will cause you to crash
if you come in contact with them. (See Figure 27.) Candles give you
a slight uplift, but make sure you don't fly too close above them.

Maneuver your glider over vents to gain height using the left and
right keys. Your goal is to make it safely to the right side of the room.
When you succeed in crossing a room safely, you enter the next room
at the same height you exited the previous room. (See Figure 28.)

To view Glider's built-in help, choose About Glider from the
Apple menu and then click the Help button.

Mastering Glider

I asked Glider's author, John Calhoun, for a tip I could share with
you. He said, "Tips for playing Glider? Wiggle. Wiggle to rise,
wiggle to fall."



Marvelous Macintosh Games

extra glider

for points
+ Good +

outlet

copter

water

Be careful!

Figure 27. The Good, the Bad, and the Be Careful:
Some things are good, others bad; candles can be both, depending on how
close you fly to them.

That's a good tip—the wiggle is a skill you'll have to master to
become an expert at Glider. To wiggle, tap the left and right keys in
rapid succession. If you're doing it right, your glider will rise fluidly
when if s over a vent.

Another thing: When you crash a glider in a room, your next
glider starts in the top left comer of the same room. Because you start
out so high, you can get safely through many of the rooms by simply
putting the pedal to the metal—mash down on the period (right) key
as soon as possible and don't let go. It doesn't work in rooms 3,13,
and 15, but it seems to work in most of the others.

There is a thermometer in the middle of room 12. If you touch it,
as shown in Figure 29, the vents in this room and the next one will
be activated. If you don't touch it, the vents won't work. You can get
through these two rooms without touching the thermometer, but if s
much harder.
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Figure 28. Leaving and Entering Rooms:
Your glider enters the next room at the height that you exited the previous
room.

Entering Room 2

Figure 29. Touch This Thermometer:
If you touch the thermometer in room 12 as shown, you turn on the vents in this
and the next room; if you don't touch it, the vents don’t blow air.
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After playing for a while, you should be able to reach the final
room. When you do, you're sure to have some trouble with the cat.
I've made it past the ferocious feline once or twice, but I'm not sure
how I did it. I asked author Calhoun about this one, and he replied,
"Seems the way out of the room is the open window. Seems rather
that the cat has other plans. Seems no matter how you approach it,
the cat swats you right out of the sky. A really quick chap might be
able to pull back out of the way just in time. But then, of course, that
doesn't get you out the window. Unless, perhaps, the cat is a little
delayed on that next swat."

I'm not sure what he means, but if you do make it to the final
room, keep it in mind.

Glider: The Fine Print

'Tuelivedon the plains of Kansas all my life, go to the University of Kansas,
and will be certified to teach high school English and physics, probably by
the time you read this. I love thinking of computer games to write, hate
writing them, and then wind up hating them when I've finished writing
them. But I keep doing it! Instead, I prefer to paint (thefigure), play the guitar
(well, make noise), write poetry, and take apart everything I own (I'm afraid
it's compulsive—my VCR still works the way it is, but you wouldn't
recognize it as a VCR)."

John Calhoun

Glider is shareware. John would be really grateful for $8, but if
that seems too steep, send what you think is appropriate to John
Calhoun, P.O. Box 442258, Lawrence, KS 66044.



Gobbler
A friendly snake named Hedda wanders about
gobbling mushrooms. It’s simple enough for kids,
and challenging enough for grown-ups.

Gobbler is a snake-eats-mushroom game starring a friendly snake
named Hedda, a variety of stones, and occasionally, some bonus
chests. Hedda is lost and very hungry. Your job is to make sure she
eats plenty of mushrooms and to guide her home. If she runs into a
wall, a stone, or into herself, she'll lose a life, so be very careful.

Playing Gobbler

Gobbler is a classic snake-eats-objects game, similar to the arcade
game, Centipede. You control Hedda Gobbler, a hungry snake
who's lost her way home. You'll have to eat the mushrooms, pick up
bonus chests quickly before they disappear, and pass through the
exits of fifteen rooms to win the game.

To begin playing Gobbler, double-click its icon. The default keys
for controlling Hedda are the K (left) and L (right) keys. If you would
prefer using the Z and X keys for left and right respectively, choose
them from the Options menu. These keys move Hedda left and right
based upon the direction she's headed, which means they do not
always cause her to turn left or right on the screen. You have to think
about which way she's headed to know which way she'll turn when
you press a particular key.

Next, choose a speed from the Speed menu. It's easier to learn
the game at the Slow speed, but you'll score more points in the
Normal or Hyper modes.
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Now you're ready to play. Choose New Game (Command-N)
from the File menu. A game will start. You'll start out with four lives,
and receive another life for every 2,000 points you score. Guide
Hedda to mushrooms and bonus chests using the left and right keys.

There are fifteen levels. On each level, Hedda must eat a certain
number of mushrooms before an exit will appear. That number,
along with the current level number, number of lives remaining, and
your score, are displayed across the top of the screen for your
convenience. (See Figure 30.)

Figure 30. Gobbler:
You control the snake; your status is displayed across the top of the screen.

You get a bonus for each level you complete, based on the length
of Hedda when you exit the level and the speed you've selected from
the Speed menu. Hedda shrinks when she loses a life. Try to catch the
bonus chests that appear from time to time. They're worth between
100 and 500 extra points, but you have to be quick; they disappear
after a few moments.
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When Hedda has eaten all the mushrooms on a level, the exit will
appear. You can go into the exit from any direction not blocked by
a wall or a stone. (See Figure 31.) Each level is a little faster and has
more stones.

Figure 31. Exiting a Level:
Hedda can go into an exit from any direction not blocked by a wall or a stone.

There are three ways to pause in the middle of a game: press the
spacebar, choose Pause from the File menu, or type Command-P.

To view Gobbler's built-in help, choose Help from the File menu
or type Command-H.

Mastering Gobbler

Perhaps the hardest part of mastering Gobbler is perfecting your
turning technique. The left (K) and right (L) keys always turn to the
left or right as seen through Hedda's eyes. If her head is pointing any
direction but up, the result of pressing one of the keys may not be
what you expect. (See Figure 32.)
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Figure 32. Hedda Turns:
Hedda turns to her left when you press the K; to her right when you press the L.
The results, depending on which way her head is facing, may not be what you
expect.

Practice makes perfect. You'll crash into rocks and walls a few
times, but eventually, the logic behind the controls becomes second
nature to you, and you don't lose lives as often. My wife claims that
she turns her head in the same direction Hedda is facing to orient
herself to Hedda's controls. She says it also helps if she turns her head
periodically during a level, and especially at the beginning of a new
level, to reorient herself. Try it. It works!

Think ahead. The longer Hedda gets, the harder she is to
maneuver. There's no time limit, so take your time. Many times it's
safer to take a longer route to a mushroom or bonus chest. You only
have four lives (at least until you get 2,000 points—you win a bonus
life every 2,000), so be careful with them. It's better to go the long way
than to lose a life. And when Hedda gets long, be particularly
cautious. The longer she is, the more bonus points you receive when
you go through the exit. But remember: The longer she is, the more
likely you are to run into yourself.
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Go for bonus chests whenever possible, but do it carefully. Even
a 500-point bonus chest isn't worth losing a life over.

Here's another tip from my wife, Lisa, who's become something
of a Gobbler guru. (You'll see her name—she goes by Ally's
Mommy—if you choose Show High Scores from the Options
menu.) She says, "Don't be hasty to turn Hedda as soon as you eat
a mushroom (unless you are about to die). Look for the next
mushroom first, and then decide which way to go. It's real easy to get
into the 'one-way-tum-only' mode. (I know several drivers who
only make right turns.) By not rushing to make a turn in the same
direction you have been making, you might be able to snag a
mushroom along the way. But don't get cocky. Better safe than sorry
(or dead). The life you save may be one of Hedda's."

Gobbler: The Fine Print

"I tried to design Gobbler so that it would remain challenging even after the
player conquers all fifteen levels. I hope you'll enjoy it and find it addictive.
If you register Gobbler, I'll send you a personalized and registered copy of
the latest version. You'll also be advised of any possible updates, as well as
information on my next project, a computerized, role-playing fantasy game
filled with puzzles,swordplay, treasure, magic,and—I hope—excitement."

Les Blatt

Gobbler is shareware. If you like it and keep it, please send $10
to Les Blatt, 21 Suffolk Avenue, Maplewood, NJ 07040. For $15,
you'll get a personalized copy of Gobbler, along with the source
code, written in Think Pascal.
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Klondike
If you like playing solitaire, you’ll love playing
Klondike.

If you're a solitaire fan, Klondike is a computerized version you're
going to love. It's a faithful re-creation of the card game you play by
yourself, with two interesting scoring options: Casino and Regular.
Or you can turn the scoring off and play just for the fun of it. Either
way, Klondike provides a totally convincing game of solitaire, in
black-and-white or color (on Macs so equipped).

Playing Klondike

Rather than reinvent the wheel, I'm going to reprint the information
you'll find in Klondike's excellent Help system. It does a better job
than I could ever do of explaining how to play this delightful solitaire
game. Kudos to game author Michael A. Casteel for such straightfor­
ward, understandable directions.

The Layout: When you start the game, you will see the basic
layout of Klondike solitaire in the Game window: The "deck" in the
upper left corner, the four "foundations" to the right of the deck, and
the seven columns of the "tableau" below them.

As the game begins, Klondike deals twenty-eight cards from the
deck into the tableau. Tire number of cards in each pile increases
from one to seven from left to right. The top card of each column is
faceup, the rest are facedown. (See Figure 33.)
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Figure 33. Starting a Game:
The game window as it appears when you start a game.

The Game: The object of the game is to build all the cards faceup
on the tableau and foundations. Each foundation builds upward, in
sequence, from the ace to the king. Only aces may be moved to an
empty foundation, and only the next higher card of the same suit can
be added to the foundation.

Build on the faceup cards in the tableau in a descending se­
quence of alternating colors (shades on the Macintosh screen). For
example, only the nine of hearts or diamonds (red suits) may play on
the ten of spades (a black suit). All the faceup cards in a column may
be moved as a single unit onto another column, if suits and values
permit. (You are allowed to move a single card when there are other
faceup cards under it, but you will be assessed a scoring penalty. (See
Scoring.) The lowest card of a sequence is always available to play to
a foundation.

Whenever the faceup cards in a column are moved, the uncov­
ered facedown card becomes available to turn up. Only a king, or a
sequence headed by a king, may be moved to an empty column.

Starting the Game: Press the Play or Replay button in the Scores
window, or choose New Game from the File Menu. The Game
window will be brought to the front and Klondike will deal the cards.
If you pressed the Play button, Klondike will first shuffle the deck;
Replay allows you to retry the last shuffle in another game. (See
Figure 34.)
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Figure 34. Your Name Here:
Type your name in the box, then click the Play button.
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players' names in text boxes.
Choose next player with radio
button.

Playing the Game: It is easy to play Klondike. You move cards
between the deck, tableau, and foundations by dragging them with
the mouse. Position the mouse pointer on the card you wish to move,
press and hold the mouse button, and move the pointer to the
destination pile. This will "drag" an image of the card along with the
mouse pointer. When the outline of the card touches a legal destina­
tion, the destination will be highlighted. Release the mouse button
when the highlight appears and the card you "picked up" will move
to the destination.

To move an entire faceup pile of cards, position the mouse
pointer on the highest card (i.e., the one deepest in the pile) and drag
the pile.

To turn up the top card in an uncovered, facedown pile, position
the mouse pointer on it and click once. Clicking is also used to turn
up the next card (or cards) in the deck.

To move a single card to the foundations, you may double-click
on the card instead of dragging it.

If you wish to see the suits of the cards in the middle of a faceup
pile, position the mouse pointer on any of those cards and press the
mouse button. The pile will be expanded to fill the screen as long as
you keep the button depressed.
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The Options Menu: This governs the game options: Show
Score, Sound On, Casino Game, Play Out, and Turn Three/Turn
One. With System File 4.1 and later, the Red Suits, Card Backs and
Animation menus also appear as hierarchical menus under the
Options menu. Klondike remembers your selections on the Options
menu from one run to the next.

When Show Score is selected, a running score appears in the
Game window during the game. If the Scores window has not been
closed, it will be brought to the front at the end of each game.

When Sound On is selected, Klondike will produce sound
effects at the start of each game and whenever you win a game.

Selecting Casino Game lets you score Klondike according to the
common wagering scheme (see Scoring) instead of Klondike's
original video game style of scoring.

Selecting Play Out lets you keep playing after you turn up the last
card until you have moved all cards up to the foundations. Nor­
mally, Klondike scores your win when you turn up the last card.

Turn Three and Turn One allow you to choose whether you
want cards from the deck turned up three at a time (default) or one
at a time.

The Help Menu: This allows you to open Help windows for
explanations of Rules, Play, Scoring, or News (about this version of
Klondike), and allows you to Show Aces.

After exacting a scoring penalty, Show Aces will show you
where all the facedown aces are (if any) in the tableau. Play stops
until you click the mouse button once more to hide the aces and
resume play.

The Red Suits menu allows you to choose any of the standard
Macintosh colors as the color for Hearts and Diamonds suit symbols,
or to pick your own color from the Macintosh Color Wheel. For
legibility, a gray pattern is used instead of black.

The Card Backs menu allows you to choose which color to use
for the card back pattern.

The Animation menu allows you to choose which type of
representation Klondike will use while dragging cards around the
screen. Full drags a complete image of the card(s) (memory permit­
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ting); Ghost drags an interesting rendition of the card(s); Outline
drags a gray outline of the card(s).

Scoring for the Casino Game: Scoring is according to the
common wagering scheme: You "pay" $52 to begin play, and you
wm $5 for each card played on the foundations.

Scoring for the Regular Game: Tins version is scored more like
a video game, including a penalty for slow play. In the regular game,
scores are accumulated as follows:

PLUS Points (Maximum available: 735 points)
° Five points: Adding a card to the tableau, either by

playing one from the deck or by turning over the top
card of an uncovered column. Maximum: 220 points.

° Ten points: Adding a card to the foundations, either
from the deck or the tableau. Maximum: 520 points.

MINUS points:
° Minus two points: Every fifteen seconds of elapsed

time, while the Game Window is active.
° Minus five points: Moving a single card from one

column to another column when there are faceup
cards under it.

° Minus five points: Moving the top card from a foun­
dation to the tableau.

° Minus twenty points: Using the Show Aces function
to uncover the facedown aces in the tableau.

° Minus twenty-five points: Each pass through the deck
after the first three passes, when turning up three
cards at a time.

o Minus one hundred points: Each pass through the
deck after the first pass, when turning up one card at a
time.

In addition, a winning bonus is calculated as follows:

[(end-of-game score) - (1 point per elapsed second)] x 10.

The game is won when all cards are faceup in the tableau and
foundations, with none remaining in the deck.
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Since the maximum end-of-game score is 735 points (assuming
you took no time to win the game!), the largest conceivable bonus is
7,350 points. Total scores of over 6,000 can actually be achieved.

Mastering Klondike

Either you enjoy solitaire, or you don't. If you do, you'll like playing
Klondike. It's just like playing with a deck of cards, but with
Klondike, you receive a brief musical interlude as a reward when
you win a game.

Here's a tip for those of you with color monitors: Choose Red
from the Red Suits submenu in the Options menu. Much better now,
eh?

As far as how to master it, there's not much I can say. A lot of it
is the luck of the deal. My advice is to be careful not to pass up
opportunities when you're playing for points—it can be costly.

Better still, turn the score off altogether. A long time ago, when
I used to play solitaire at a table with a deck of cards, I could go on
for hours, just for the fun of it. Playing Klondike with the score turned
off is just as enjoyable.

Klondike: The Fine Print

Klondike is shareware. If you enjoy it, please send a payment of $10
to Unison Software, 675 Almanor Avenue, Sunnyvale, CA 94086.



Mac Pong
Mac Pong is electronic Ping-Pong, like the game
you paid a quarter to play many years ago.

Way back in 1972, Nolan Bushnell started a company called Atari
and created the first arcade computer game ever—Pong. Since then,
there have been dozens of computer games based on the Ping-Pong
theme, and Mac Pong is among the best. If it's too easy or too hard,
a few simple controls let you fine-tune Mac Pong to be the perfect
competitor for you. You'll want to play again and again.

Playing Mac Pong

Mac Pong is similar to Ping-Pong. The object is to hit the ball past
your opponent. The player who lost the previous point serves. You
score a point when your opponent misses, and vice versa. Unlike real
Ping-Pong, you can score a point even when you aren't serving. The
game ends at twenty-one points.

To begin playing Mac Pong, double-click its icon. A game will
immediately begin. You use the mouse to control the paddle on the
left. The first serve will come right down the center of the playing
field toward your paddle. (See Figure 35.)
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Figure 35. Right Up the Middle:
Mac Pong always serves right up the middle.

When a game begins, the settings are: Skill = Average, Sound
turned on, Speed = Average, and Mode = Normal. (See Figure 36.)

File
Pause
Restart
Quit

Skill 1 Sound |
Bad Turn Off |
Poor

>/Ruerage
Good
Expert

Speed
Uery Slow
Slow

✓ Normal
Fast
Uery Fast

✓ Normal
fiutoPlay

Figure 36. Default Menu Settings:
When you start the game, it will be configured as shown; you can make it
easier or harder by changing the speed and skill levels.

The defaults are good settings to get started with. Play a few
games. If you find it too challenging, choose Slow or Very Slow from
the Speed menu and/or choose Poor or Bad from the Skill menu. If
it's too easy (which is unlikely), choose Fast or Very Fast and/or
Good or Expert. You can mess around with the Skill and Speed
settings until you've created the perfect opponent. If you want to see
how fast your settings will play, choose AutoPlay from the Mode 
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menu. This will start a demonstration—computer vs. computer—
using the current settings you've chosen. To end AutoPlay, choose
Normal from the Mode menu.

You can pause the game by choosing Pause from the File menu;
you can forfeit the current game and begin a new one immediately
by choosing Restart.

I find the sound annoying and generally play with it turned off.

Mastering Mac Pong

There's not much to say. Practice makes perfect. To master Mac
Pong, you must play Mac Pong. Again and again. Of course, it helps
to have good reflexes, but if you play this game often enough, your
reflexes will get better.

If you find yourself winning consistently, alter the skill and
speed settings to make it more challenging.

For inspiration, choose Expert from the Skill menu, and Very
Fast from the Speed menu. Then choose AutoPlay from the Mode
menu. Whoosh!

Keep your eye on the ball. Try to anticipate where the ball will
be when it gets to your end of the field and move your paddle there
before it arrives.

Mac Pong: The Fine Print

Mac Pong is shareware. Donations of $5 are gratefully accepted.
Please send them to David L. O'Connor, 32 Pond Valley Circle,
Penfield, NY 14526.





MacPente
MacPente—a brilliant interpretation of Pente, “the
classic game of skill. ”

Take elements of checkers and tic-tac-toe, mix in a dash of the
popular oriental game, Go, then add a sprinkle of chesslike strategy.
What do you get? Pente, the classic game of skill. Pente is most
enjoyable when played against a skilled opponent, and MacPente's
human vs. computer option is quite proficient, even at the Beginner
level of play. If you love a good, logical, fast-playing game of skill,
MacPente should do the trick.

Playing MacPente

The object of Pente is to capture five pairs of your opponent's stones
(ten stones), or to get five stones in a row either vertically, horizon­
tally, or diagonally. You take turns placing one stone anywhere on
the board. Play continues until one player has captured ten of his
opponent's stones or created a line of five of his own stones.

To begin playing MacPente, double-click its icon. In the first
dialog box to appear, click the Test Drive button; in the second dialog
box, click the Continue button. The MacPente board will now
appear, with one white (they appear gray on screen) stone in the
middle. (See Figure 37.)
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Figure 37. Starting MacPente:
The board as it appears when you start playing, with one white stone placed in
the middle.

MacPente's default mode is Two Human Players, so if you want
to play against the computer, choose Computer Plays White from
the Players menu. If you do this, you'll be playing Black, and it will
be your turn to move, by clicking the intersection where you want
your stone to appear. When you've completed your move, the
computer will move. Then you move. And so on.

If you choose Computer Plays Black, the white stone in the center
will be considered your first move, and it will be the computer's turn
to move. When it completes a move, it will be your turn to move
again. Then the computer moves. And so on.

To play against another human, choose Two Human Players.
Captures: Stones can only be captured in pairs. To capture a pair

of stones, you must bracket them with your own stones, in a straight
line. Captured stones are removed from play. (See Figure 38.)
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Figure 38. Captures:
Placing the white stone as shown and bracketing the two black stones (clock­
wise) vertically, horizontally, or diagonally, will capture the pair of black stones.

Five-in-a-row: Five-in-a-row must be in a straight consecutive
line, and can run horizontally, vertically, or diagonally.

Play continues until ten of one player's stones have been cap­
tured, or completes five-in-a-row.

You can choose how fast and well the computer plays using the
Level menu, though I strongly suggest leaving it set to Beginner for
a while.

To begin a new game at any time, choose New Game from the
File menu.

To see MacPente's built-in help, choose About MacPente from
the Apple menu, then click the Help button.

By the way, the Options menu is inactive unless you pay your
shareware fee and receive the key. If you do, you'll gam access to
features like Undo (take back the last move), Hint, and several
others.
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Mastering MacPente

Pente is a simple game, yet strategies can be incredibly complex. I've
seen entire books about winning at Pente; I think I even read one
once. My wife and I have passed many a pleasant hour playing
Pente—we once had a magnetic Pente board (which I haven't seen
in years) for planes and beaches.

The best advice is to be aggressive. When you' re on the offensive,
you're controlling the game; when you're doing nothing more than
blocking your opponent's three-in-a-rows, you're courting disaster.
Play offensively—seize control early and don't let go.

Getting five in a row is the easiest way to win. You'll win more
often if you make this your objective than if you try to win by
capturing ten stones. Capture stones when it's to your advantage,
but work aggressively to make five-in-a-row.

Three-in-a-row is extremely dangerous. If left untreated, you
can win (or lose) a game in two moves. So try to create lots of three-
in-a-rows while trying to prevent your opponent from creating
them. Watch closely; if a move can create two three-in-a-rows that
are unobstructed by your opponent7s stones, you'll win in two more
moves.

One thing I remember from that Pente strategy book was to try
to build a structure called the "dreaded X": two intersecting three-
in-a-rows. (See Figure 39.) In the figure, you'll see that I created a
dreaded X, then went on to build one of its "facets" into a five-in-a-
row.

If you can build a dreaded X, you will usually win the game
shortly. There are so many ways to build three- and four-in-a-rows
that it's almost impossible to lose.

The dreaded X is made up of three-in-a-rows, which are pretty
potent structures themselves. Don't underestimate them. If you
can't make a dreaded X, try making a three-in-a-row. Conversely,
don't let your opponent make three-in-a-rows. If a three-in-a-row
isn't blocked, it turns into a four-in-a-row; a four-in-a-row that isn't
blocked wins the game.
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Figure 39. The Dreaded X:
The dreaded X formation (shaded) was the key to this win.

MacPente: The Fine Print

"Shareware offers immediate feedback to its authors, and empowers the
users. If you like a program, pay a small fee for it. If you have suggestions
on how to make a program better, or you just love it, tell the author. If you
don't pay and don 7 offer suggestions on how to make a program better, the
author of a good program may leave shareware and go commercial ($$$).
Can you imagine paying first for something that you don't like? You always
take that chance with commercial software. My wife Rhoda and I hope that
you enjoy this version of MacPente."

Game Hints:

® Avoid placing two stones side by side.
° Creating an X pattern usually leads to a winning game.
° Keep the offensive!
° Jumping to destroy a structure is usually preferred to

blocking it.

Fred Moulden, Jr.
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MacPente is shareware. If you like it, please send $15 to Fred
Moulden, Jr., 6536 S. Sangamon, Chicago, IL 60621. When you've
paid for the program, you'll receive a key to unlock the Options
menu plus the next version of the program for free.



Nuke Snake
You command a nuclear-powered, torpedo-firing
snake in a fight to the finish.

Nuke Snake pits you against either the computer or another human
opponent. You control a nuclear powered snake (this one doesn't
have a name). The object is to kill your opponent with torpedoes
while avoiding obstacles. And Nuke Snake is exceptionally
configurable. You can start out playing a simple game with few
obstacles; then, when you've got a feel for commanding a nuclear
snake, you can add elements like Ammo Packs, Terrain, Diagonal
Movement, or Mines. Nuke Snake also plays in color on Macs that
are so equipped.

Piaying Nuke Snake

In Nuke Snake, the object is to use your torpedoes to kill the other
snake before it kills you. This is to be accomplished while avoiding
obstacles and dodging enemy torpedoes. You'll need quick reflexes
and a keen strategic instinct to master this one.

To begin playing Nuke Snake, double-click its icon. You control
your snake using either the regular keyboard or numeric keypad if
you have one. (See Figure 40.)
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1 Player
(keyboard or numeric keypad)

2nd Player
(keyboard only)

Figure 40. Keyboard Controls:
These keys control your nuclear-powered snake.

The playing field is surrounded by stones that conceal exits and
entrances. You must blow away the stones with torpedoes to use an
exit. Don't forget to blow away both stones—the entrance and exit.
When you do, you reenter the field at the same place on the opposite
side.
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The stones aren't the only things that will kill you—so will the
snake tails, which both snakes leave behind when they move.

Figure 41 will show you what is what.

Figure 41. Nuke Snake:

1. Your snake.
2. Your opponent’s snake.
3. Torpedoes.
4. An exit/entrance.
5. Another exit/entrance—you’ll reappear here if you exit at

exit/entrance #4.
6. Snake tails.

Nuke Snake is very configurable. Figure 42 shows the defaults.
Your copy of Nuke Snake should have these settings the first time
you use it.

To play a game, choose New Game from the File menu. As long
as Single Player is checked in the Extras menu, you will play against
the computer. A new game will start. It continues until one player
achieves ten points.
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Figure 42. Default Menu Settings:
When you start the game, it will be configured as shown; you can make it
easier or harder by changing any of the settings.

The defaults are good settings to get started with. Play a few
games using these settings until you get comfortable with the
keyboard controls. Once you feel in control, start adding Extras and
changing Speeds to create the perfect Nuke Snake game for you.

The Speed menu allows you to adjust the speed of the game from
1 to 10, with 10 being the slowest and 1 being extremely fast. The
default speed, 7, is good for learning the game. Later, when you're
more skilled, try playing at a faster speed—it's Eke a whole new
game.

The Torpedoes menu lets you choose the speed at which torpe­
does travel. The default, 6X, is a good speed for learning the game.
Later, when you become more proficient, try slower torpedo speeds.
Again, it's like a whole new game. With slow torpedoes, you often
have time to dodge an incoming one, if your reflexes are good
enough.

Tails make the game much more challenging. When they're
turned on, both snakes leave a trail behind them. These tails kill
snakes on contact. You can blast your way through a tail with
torpedoes. I like the game better with the tails turned on.

Finally, there's the Extras menu. This is where you can really
make Nuke Snake an altogether different game. Just choose one or
more of the options and the game will be entirely unlike it was before.
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All the choices in the Extras menu are toggles—a check mark in front
of a name means it's turned on. To turn it off, choose it again, and the
check mark will disappear.

° Sound turns the sound on and off.
° Mines puts explosive mines on the playing field.

When either snake shoots them, they explode, spray­
ing shrapnel in all directions. (See Figure 43.)

Figure 43. A Mine Explodes:
When a mine (top) is hit by a torpedo, it explodes, sending shrapnel in all
directions (bottom).

° Ammo Packs give both snakes a limited supply of
torpedoes. They must pick up ammo packs to replen­
ish their stock. The score at the top of the window
changes to reflect both your number of kills and the
number of torpedoes you have remaining. (See Figure
44.) Unless Ammo Packs is checked, both snakes have
unlimited torpedoes.



Marvelous Macintosh Games

S Score: 0 -- Ammo: 0  Score: 1 -- Ammo: 9

oo
•••

Figure 44. Ammo Packs:
When you choose Ammo Packs, your torpedo supply is limited. You must
collect ammo packs—the little pyramids made up of 6 torpedos—to replenish
your supply.

• Linear Terrain and Fractal Terrain add an assortment
of rocks, trees, and water to the playing field.

• Stop At Water causes snakes to be unable to proceed
when they run into water. The water won't kill them,
like stones or tails, it merely prevents further forward
motion.

0 Diagonal activates the diagonal movement keys. If it
is checked, your snake can travel in a diagonal line
when the appropriate key—7,9,1, and 3; or U, O, M,
and period for player one, and Q, E, Z, and C for
player two—is pressed. If Diagonal is not checked,
snakes can only move vertically or horizontally.

• Single Player designates which opponent you play.
When it's checked, you play the computer; when it's
unchecked, you play another human.

Mastering Nuke Snake

When you're first starting out, take it easy. Turn all the Extras off,
turn the Tails off, and play at a slow speed. Get used to the way your
snake handles. Only add Extras and increase the game speed when
you're comfortable driving a nuclear-powered snake.

When you change settings, choose Demo from the File menu. A
demonstration game will play using the settings you've selected. It
often helps to watch a few demo rounds, with the computer playing
against itself, before you play it. When you're ready to play, choose
New Game from the File menu.



Nuke Snake

There are a lot of keys to keep track of. You might find it useful
to keep the page with Figure 40 nearby when you're learning the
game. Also, if you're pressing keys and nothing is happening, glance
down to see if your fingers are on the proper keys.

But why take my advice? Who should know better than David
Riggle, who wrote Nuke Snake? He offers his very own words of
guidance below.

Nuke Snake: The Fine Print

"My best friend Marshall Spightand I have played Nuke Snake almost every
week since I finished it (almost a year now), and we have found it to be a
remarkably subtle game. Just when we think we have mastered it, we
discover new nuances of strategy. We frequently play late into the night,
much to the chagrin of our wives, to whom Nuke Snake has become
something of an institution. Our favorite playing options are as follows:
speed = 3; torpedoes = 5X; tails off; sound, ammo packs, and terrain on. We
play on a Mac II with an Apple 13" color monitor.

"One of the first strategies that Marshall developed zvas to hoard ammuni­
tion (we call ammo packs "food" and we call the sound that plays when you
pick them up the "dinner bell"). He likes to grab all the ammo that is near
him and shoot all the ammo that is near me. It is quite an effective strategy.
Sometimes he'll even sacrifice himself by running into a wall to prevent me
from getting ammo. I often find myself "embarrassed," or without any
ammo. When that happens, he gleefully hunts me down, zohile I try to avoid
his fire and maneuver for a collision—my best hope in such a situation.

"One of my favorite things to do is to shoot a hole through both zvalls and
set up a circulating torpedo trap. Marshall is drazon to these like a moth to
a flame; I think he enjoys trying to shoot them dozen. As often as not, he dies
in the attempt, and I score.



Marvelous Macintosh Games

"Another one of Marshall's favorite tricks is to hide in the trees. If I go in after'
him, he breaks into the clear, shooting the tree right in front of me. Because
explosions persist for a second or two, I almost always blunder into the
burning tree and die. We call this coup de grace the "tree shot." If a tree shot
is self-inflicted (i.e., you shoot a tree and then blunder into the explosion),
Marshall calls it "the bug." I don't think he likes that feature much.

"Nuke Snake is based on a game of the same name that I wrote for the
Commodore PET in 1978, when I was a junior in high school. Since then,
I have gone on to receive a B.S. and M.S. in computer science from U.C.
Berkeley and have worked at Xerox and Claris. I am currently self-
employed."

David Riggle

Nuke Snake is shareware. If you enjoy it and want to finance
more, please send $10 to David Riggle, 3745 Crenna Avenue,
Concord, CA 94519.



Scarab of RA
Wander around collecting supplies and artifacts in
this amazing maze game with hundreds of levels.

Scarab of RA is an enormous maze game. You are an intrepid
archaeology student; your mission is to explore the Great Pyramid
of RA. Dozens of explorers have entered the pyramid before you;
none have ever returned. Your adventure begins at the top of the
pyramid and starts with the relatively easy level 1 maze. Each level
is a more difficult maze whose exit leads to the entrance of the next
level down. On each level you'll have to find a key, pick up food,
weapons, and sacred relics, and deal with angry animals and
guardians. It's a fascinating game—you can spend many hours
exploring the Great Pyramid of RA.

Playing Scarab of RA

In Scarab of RA, you play explorer and archaeology student Missis­
sippi Smith, exploring the mythical Great Pyramid of RA. In the dark
of night you've crept into the pyramid. You've stolen a lantern and
some oil, and expect to find abandoned food and equipment left
behind by other earlier expeditions—ones that didn't make it out
alive.

The pyramid is divided into floors (levels) and each level is a
maze whose exit leads to the entrance of the next level down. The
doors are one-way; after entering a level, the door slams behind you
and you cannot return through it. You must find the exit door, but
it will be locked and useless unless you find the key first.
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You'll find things other than keys as you explore: the lost and
abandoned detritus of earlier explorers, piles of gold left by ancient
RA worshippers, dangerous animals, and hidden traps. Most im­
portant, though, are the three sacred talismans of RA: his crown, his
staff, and his scarab. All three are hidden somewhere in the pyramid;
if you find all three and exit a level successfully, you have won the
game.

To begin playing Scarab of RA, double-click its icon. A new game
begins automatically. You are standing inside the door to the first
level of the pyramid with sixteen ounces of food and a lantern. You
have no gold nor prestige, but your health is good and you are full
of food. You carry almost nothing, so your weight is low and you can
move quickly. (See Figure 45.)

d Game Edit Map Speed Inuentory Help Hints

Figure 45. Scarab of RA:
Scarab of RA’s five windows—Movement, News, Inventory, Status, and the
main window, Scarab of RA, which shows the view through your eyes.



Scarab of RA

Figure 45 shows the game as it might appear when you first start
out. It could look different when you start, as every maze is different
each time you play (so don't bother memorizing them!). Also, the
location of items inside the pyramid changes from game to game, so
don't bother memorizing them, either.

There are five windows. The largest, Scarab of RA, shows your
view of the pyramid. This is where you'll see every tiling in the game:
walls, corridors, gold, food, etc. The view in this window changes as
you move. Normally, it changes once each time you click on an
arrow button in the Movement window. But animals can move
faster than you, and sometimes your view will change several times
for one click to show you the motion of an animal.

To explore the maze, use the arrow buttons in the Movement
window. The black arrows move you one space, the hollow arrows
allow you to "peek" to the left, right, and behind you, the watch
allows you to pass time without moving. When you peek, you aren't
moving your feet. You can also use the keys on the numeric keypad
(if your keyboard has one) to navigate. (See Figure 46.)

Mouement

Pick Up

Figure 46. Keyboard Controls:
Click the solid arrows to change direction and move, the hollow arrows to peek,
and the wristwatch to wait. Or, use the numeric keypad.

The solid curved arrows change the d irection that you are facing,
but don't change your location. The/re like a soldier doing a left,
right, or about-face. The solid straight arrows move you backward
and forward. These are the only two buttons that change your 
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location. So to turn a comer you must get to an intersection, click a
solid curved arrow to change the way you're facing, then click the up
arrow to move in the new direction.

It's harder to describe than it is to do. You'll be used to it in just
a few games. If you hear a beep and yourviewdoesn'tchange, you're
trying to walk into a wall. Change direction and try again.

If you have trouble figuring out where doors and walls are at
first, choose Which Way Can I Go from the Map menu. It will tell you
which directions you can go from where you're standing. After a
while, you won't need this command anymore.

The window titled News is where you get messages about
what's going on in the pyramid. (For example: "You found a key,"
or "You awakened a sleeping lioness," or "The door creaks open ...
... and slams shut after you pass through.") When you find an object,
you have the option of picking it up or not. If you do pick it up, it will
be listed in the Inventory window. You can then Drop (Command-
D), Get Info (Command-I), Throw (Command-T) or Use (Com-
mand-U) any item by clicking its name in the Inventory window,
then choosing the appropriate command from the Inventory menu
(or using its Command-key shortcut).

You can see your current status—prestige, gold on deposit,
speed, health, hunger, and weight you're carrying—in the Status
window. For a more complete description, select Full Sta tus from the
Game menu.

Good explorers draw a map; your map is automatically drawn
for you as long as you move slowly enough. At speeds of 5 or less,
places you walk are added to the map; at speeds higher than that,
you're moving too fast to map. At speeds of 3 or less, corridors you
look down but don't walk down are added to the map. Looking
down a corridor means using the solid arrow keys, not the hollow
"peek" arrow keys. You can even attach your own notes to any
location you've been to. The map is a great asset; learn to use it and
you'll find the game much easier. To look at your map, choose See
Map (Command-M) from the Map menu. (See Figure 47.)



Scarab of RA
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Cancel New Note

f Put Map Rway j

ou are hereV
Notes pointer
Mapped and walked
Mapped, not walked
Unmapped

Figure 47. Maze Maps:
Map of a level I’ve totally explored. The star represents a note (Sprung Wind
Trap) I wrote to assist me in navigating.

There are details on how the maps actually work in the Help
menu items Making a Map, Reading the Map, and Map Notes.

I could write twenty more pages, but that would spoil the fun.
This game is so rich and complex, I hate to give too much away. I
suggest you read every selection in the Help menu thoroughly at
your earliest convenience. Not only is it informative, but it's imagi­
natively written and adds nicely to the game's atmosphere.

Mastering Scarab of RA

As with any maze, the "left-hand rule" and "right-hand rule" work
in Scarab of RA. The rules are simple; pretend you've placed your left
or right (pick one, then stick with it, of course) hand on a wall at the
start of the maze. Continue along making whatever turns are
necessary to keep that hand on the wall. To retrace your steps, do an
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about-face and switch hands. It's hard at first, and you'll frequently
become confused. Take my word for it; you'll soon be moving
quickly while following the rules, especially if you use the keypad
controls instead of the mouse.

Speaking of speed, I suggest you always keep it at 5 or less, so
every place you go gets mapped. I usually leave it set at 3, so even
places I've only looked at get mapped, unless I need the speed to get
past an animal or guardian. I always set it back to 3 as soon as I can.

Use your map. I once found both the crown and the staff before
reaching the fifth level because I explored every level completely
before exiting. If you don't pay attention to your map, you may find
the exit without having explored the entire level. That unexplored
territory might conceal one of the three sacred talismans. The object
is to find the key and the exit, but explore every nook and cranny on
the way.

6 Game Edit Map Speed hwpatary Help Hints
Moupmp.ni Npihs.

Yes

a
Status

Prestige: 10610 Gold: 50

You spy a passage leading to
------------ sunlight, fire you ready to
I No J end your aduenture now?

__________Inventory
an anaesthetic dart
The Crown of RR
a net
a bottle of snake bite cure
the Scarab of RR
a ten-foot pole
1 065 ounces of gold
The Staff of RR

Scarab of RR

Health:[L " . -I I Speed: 1

Hunger:[ZO Weight:!""" j|

Figure 48. Winning at Scarab:
When you place the key in an exit door while carrying all three sacred talis­
mans—the scarab, staff, and crown of RA—you’ll be given the option of ending
your adventure as a champion, or continuing to play.
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I've won the game as early as the eleventh level, having found all
three sacred talismans and gone through the exit to the twelfth level.
Though the game has hundreds of levels, you don't have to play
them all to win. The game kindly allows you to continue playing
even after you've won. (See Figure 48.)

When you ask for a hint, you have to wade through four separate
dialog boxes. (See Figure 49.) I waited as long as I could stand it
before peeking at them. Most of the time, they were worth the effort.

Last chance to be a hero.
Still want that hint? El

•- ±-.= Hints on Hieroglyphs = =

| Done [ Neat ] ( Previous ]

The hieroglyphs on the walls are O
taken from "The Book of Knowing
the Evolutions of RA, and of
Overthrowing Apep". They have no
bearing on your own difficulties, so
don't kill yourelf trying to translate
them.

The English messages on the wall,
however, are usually true.

O

Figure 49. How Badly Do You Want That Hint?
Scarab of RA makes you work hard if you want a hint, but they’re usually worth it.
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Last but not least, read every thing in the Help menu. I've given
you the basics, but there's much more to this game than meets the
eye. Take a few minutes and read all the help screens. You'll enjoy
the game much more after you do.

Scarab of RA: The Fine Print

" When I was a boy, I loved mazes. But I always thought it was cheating (and
worse, boring) to solve a maze starting with a complete map. I wanted to
solve mazes from the inside, like Theseus in the Labyrinth of the Minotaur.

"I tried a lot of things (like string mazes in the backyard, that you had to run
blindfolded by feel), but nothing worked well... until years later when I
discovered the personal computer. Scarab of RA began as a simple maze
program: It would randomly generate a maze and show it to me as if I were
actually standing in it.Andiloved it... butthen I got to thinking how much
more fun it would be if there were things to see in the maze. And then it would
be more fun if some of those things could be picked up and used, and even
more fun if there were some hazards to avoid or overcome. And then, what
if things in the maze could move? And so it grew....

"The result is Scarab ofRA version 1.3.1 hope you enjoy playing it as much
as I enjoyed building it."

Rick Holzgrafe

Scarab of RA is shareware. If you use and enjoy it, send $10 to
Semicolon Software, P.O. Box 371, Cupertino, CA 95015-0371.



The 10 li ile Puzzle!
A simple and totally addictive brainteaser that will
enchant you for hours.

If you're the kind who loves a good puzzle, The 10 Tile Puzzle! is
right up your alley. Deceptively simple but devilishly hard to beat,
you'll try again and again to complete it in fewer than 118 moves. If
you've ever spent more than thirty seconds playing with the puzzle
desk accessory that came with most Macs, you're going to love The
10 Tile Puzzle!

Playing The 10 Tile Puzzle!

The object of this puzzle is to move the biggest, hardest-to-move
puzzle piece (piece A in Figure 50) from its original position to a
position on the other side of the board. That's all! The placement of
the other tiles is unimportant; your only objective is to move piece A
from the left side of the board to the right side of the board as shown.

To begin playing The 10 Tile Puzzle!, double-click its icon. The
game board will appear, and a new game will start. Move the tiles to
free spots by clicking on a tile, then, if the tile can go to more than one
spot, click one of the empty spots. You can also click and drag a tile
to a new spot. Or you can use the keyboard by hitting a tile's letter
or number. Then, if the tile can be moved to more than one spot,
specify which with the direction (arrow) keys.

The Snapshot feature saves your current playing piece configu­
ration in case you wish to revert to it later. To take a Snapshot, choose
Take Snapshot (Command-T) from the Control menu; to revert to
your Snapshot later, choose Restore to Snapshot from the Control
menu. Snapshots are not saved when you quit the game.
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FinishStart

Figure 50. The 10 Tile Puzzle!:
The object is to move piece A from its starting position (left) to the finishing
position (right).

If you've botched a game totally and want to start over, choose
Restore to Original from the Control menu. To see The 10 Tile
Puzzlel's built-in help screen, choose About This from the Apple
menu.

By the way, The 10 Tile Puzzle! uses colored playing pieces on
Macs so equipped.

Mastering The 10 Tile Puzzle!

There's not much I can tell you. Play for a while. It gets
easier. You can make a couple of hundred moves in five
minutes, so this is a good game to take a quick break with.

If you're curious and want to peek at the winning solution,
choose Show 118-Move Solution from the Control menu. Two new
buttons, Next and Go Fast, will appear. Click the Next to see it one
move at a time; click Go Fast to play it like a movie. (See Figure 51.)



The 10 Tile Puzzle!

Figure 51. The 118-Move Solution:
To see the solution one move at a time, click the Next button repeatedly;
clicking Go Fast will play it like a movie.

You can even cheat, if you like, by using Show Solution to do
some of the work for you. Here's how: Choose Show 118-Move
Solution, click Go Fast, and let it run until Move 70 or 80. Then click
the Next button to end the Go Fast mode. Now you can finish the
game yourself by clicking and moving the pieces. If you're smart,
you'll take a Snapshot before you make any moves.

The 10 Tile Puzzle!: The Fine Print

"If you can discover a solution that is shorter than 118 moves, then let me
know and I will incorporate your solution in the next release of this puzzle."

Andre Ouimet

The 10 Tile Puzzle! is free. Give it to everyone you know. It was
written by Andre Ouimet, who also wrote the excellent commercial
game Darwin's Dilemma.





Video Poker for Fun!
Video Poker for Fun! is like playing a poker slot
machine, but more fun and less expensive.

If you're a poker player or if you enjoy the poker video games
installed in bars and casinos, Video Poker for Fun! is a hoot. You start
with five hundred dollars; the object is to play until you're broke.
This is poker at its finest. And, unlike a real poker game, Video Poker
for Fun! never blows cigarette smoke in your face, chatters inces­
santly, gets drunk and disorderly, or spills its drink in your lap. Best
of all, no matter how much you lose, it won't cost you one red cent!

Playing Video Poker for Fun!

Video Poker for Fun! is a five-card draw poker game. You place a bet
of between one and five dollars. You are dealt five cards, of which
you can discard as many or as few as you like. New cards are then
dealt to replace your discards. The payoffs for winning hands are:

Royal Flush 800:1
Straight Flush 50:1
Four of a Kind 25:1
Full House 9:1
Flush 6:1
Straight 4:1
Three of a Kind 3:1
Two Pair 2:1
Pair of Jacks or Better 1:1
Low Pair Nothing
No pair Nothing
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Figure 52. A Hand of Video Poker:
I discarded the 9,4, and 10, and ended up a winner with a pair of aces.



Video Poker for Fun!

To begin playing Video Poker for Fun!, double-click its icon. You
start with $500. Click on the word Bet to change your wager; you may
bet between one and five dollars per hand. Click the Deal button.
Five cards will be dealt to you. Click on the ones you want to keep,
then click the Discard button. New cards will replace your discards.
If your hand now has a pair of jacks or any hand better than that, you
win. (See Figure 52.)

You can use the keyboard instead of the mouse if you prefer. Tire
number keys (and the number keys on the numeric keypad, if you
have one) turn the cards on and off, and the Return or Enter keys
press the Play and Discard buttons.

Video Poker for Fun! creates a profit-and-loss graph that you can
look at any time you like. Just click its window to activate it (if it's
showing), or choose Show Graph (Command-G) from the File
menu. (See Figure 53.)

Figure 53. Loss Graph:
The Profit Graph window. If yours looks anything like mine, you’ll think of it as
the Loss Graph window.

There are several options, all available in the Options menu.
Choosing Reset (Command-K) ends the current game and starts a
new one. Center Window moves the active window—Video Poker
for Fun! or Profit Graph—to the center of your monitor. Finally,
Select to Discard (Command-D), lets you click on the cards you want
to discard instead of the cards you want to keep. If you choose this
mode of play, the message beneath the cards changes from "Select
to Hold" to "Select to Discard."
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Mastering Video Poker for Fun!

Except for the fact that you should discard low pairs and hold every
jack, queen, king, or ace you're dealt, just use common sense. Think
about how many of the cards that you still need remain in the deck.
I'm probably not the best person to take advice from, anyway.
You've seen my Loss Graph.

If you're really interested in video poker, the author of Video
Poker for Fun! offers a commercial version for $25 which has sound,
a real time profit graph, dynamic discard statistics, helpful discard
hints, a hand improvement table, and much more.

AH I can tell you is that I follow the golden words of poker advice
that my father spoke to me the day I left for college. He told me,
"Never draw to an inside straight, a.357beatsa full houseevery time,
and it's never a good idea to play poker with a guy who has a city for
lis first name." Sage advice.

Video Poker for Fun!: The Fine Print

"I was veil/ excited when Bob asked to include Video Poker for Fun! in this
book. I hope that you have as much fun playing it as I had writing it."

Jon Maggiora

Video Poker for Fun! is shareware. Play with it for a week. If you
like it, please send $10 to Jon Maggiora, 9565 Brentford Drive,
Highlands Ranch, CO 80126. You'll receive the latest version along
with a data file for truly awesome cards and sounds.

If you like to play video poker machines in casinos and would
like to sharpen your skills, Video Poker for Real! is for you. Unlike
other video poker tutorial programs for the Macintosh, Video Poker
for Real! is not a port from DOS. Video Poker for Real! has sound, a
real time profit graph, dynamic discard statistics, helpful discard
hints, a hand improvement table, and much more. Video Poker for
Real! is commercial software and is only distributed by mail. To get
Video Poker for Real!, send $25 for the latest version as well as a
manual.



Glossary
application (a.k.a. program)
Applications are programs; they run when you double-click their icon. All
of the games in this collection are applications.

Command key/Command-key shortcut
The Command key is the one with the little "cloverleaf" or "pretzel" on it.
A Command key shortcut lets you make a menu selection without using
the mouse. Hold down the Command key and depress the appropriate key
at the same time. So, if you saw Command-E in the text, you'd press down
on the Command key and the E key simultaneously.

commercial software
Software sold by publishers in stores and by mail. Commercial software
may not be copied or given away. Tetris, Darwin's Dilemma, and Mi­
crosoft Flight Simulator are examples of commercial games.
See also freeware; shareware.

default/default settings
The settings when you first play a game, without changing any of its
settings. When I refer to a game's default settings, I'm talking about the way
it's configured the first time you use it.

Finder
A special file, part of your necessary System software, that manages
opening, closing, moving, naming, and trashing files and folders, and
mounting and ejecting disks. The Finder runs automatically whenever you
start up your Mac and is responsible for managing the desktop you see
when you turn on your Mac. You must have, at the very least, a System and
a Finder on any disk used to start up your Mac, and the System and Finder
files must always be in a special folder that must be named the System
Folder.

freeware
Software for which there is no charge and that can be copied and given
away freely. The 10 Tile Puzzle! is freeware.
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numeric keypad
The calculator keys on the right side of many keyboards. They are often
used to control games. (See Figure 54.)

Clear = / •

7 8 9 -

4 5 6 ♦

1 2 3

Enlor
0

Figure 54. The Numeric Keypad:
The numeric keypad on the Apple Extended Keyboard is laid out like this.

online service
A large, commercial BBS (bulletin board system). Online services are the
best place to look for other games like those in this collection. You can also
shop for a wide variety of products, buy and sell stocks, make travel
reservations, and search huge electronic databases for specific informa­
tion. Fees average from $5 to $20 an hour. I found every game in this
collection on CompuServe, GEnie, and America Online, which are the
most popular online services for Macintosh users.

shareware
Try-before-you-buy software. Can be copied and given out freely, but if
you use it regularly, you are honor-bound to send some money to the
author. In some cases (MacPente, Video Poker for Fun!), you receive a more
capable version if you register. In other cases, you get nothing more than
the peace of mind that comes from doing the right thing. All of the
programs in this collection except The 10 Tile Puzzle! are shareware. If you
like them, don't be ashamed to send a shareware donation. Thanks.

user group (a.k.a. MUG—Macintosh user group)
Another good resource for games like these. A user group is a club made
up of Macintosh enthusiasts which holds regular meetings and classes,
publishes a newsletter, obtains discounts on goods and services, and
maintains shareware/freeware libraries for their members. To find the
user group nearest you, call 1-800-538-9696, Ext. 500.



What kind of games are included? We believe you’ll
become hooked on all of them, including:

COLUMNS and DROPER—In the Tetris® tradition, here
are two easy-to-learn, difficult-to-master, extremely
addicting games.

CONTINUUM—A challenging, fast-paced, arcade-style
space game that places you at the controls of a highly
maneuverable space ship as it dodges hostile planets.

SCARAB OF RA—A game of intrepid archeology—your
mission is to explore the great pyramid of Ra. Dozens of
explorers have tried, none have returned...!

DARTS and MAC PONG—Like having an English pub and
a championship ping pong match inside your Mac.

FLIPIT and MACPENTE—Two board games that challenge
players to think ahead and concentrate like mad.

GLIDER—An arcade game that lets you maneuver a
paper glider through 15 fiendishly designed rooms...
beware of those candles!

KLONDIKE and VIDEO POKER FOR FUN—If you like
card games, you’ll love these!

THE 10 TILE PUZZLE—The ultimate brain teaser-only
for masochists or mad scientists!

Plus the exciting games, FLIPPER, GOBBLER, and NUKE
SNAKE!

“A mind-boggling collection of Mac games for beginners
and experts alike. The good “Doctor” has done it again!”

RUSEL DeMARIA, author, SimEarth: The Official Strategy Guide
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Computing/Computer Games

FROM THE CREATOR OF STUPID MAC TRICKS,
HERE’S “DR. MACINTOSH’S” MOST EXCITING
BOOK YET!

Welcome to Marvelous Mac Games, an incredible
collection of 15 games representing almost 1500K of
mindbending, action-packed fun.

All but one of these games are shareware. (If you’re not
familiar with the term, please turn to the preface of this
book.) From hundreds of games available in this format,
Bob and his panel of experts chose only the most excit­
ing, proven, and popular gems available—THE BEST OF
THE BEST! For roughly $1.66 per game, less than the cost
of downloading a game from an on-line service, you can
now try each of them. And there are no time-wasting
“dogs” here! Of course, you also get this handy book,
filled with detailed information, illustrations, and strate­
gies for mastering each game, all explained by the good
“Doctor” in his inimitable style.
See inside flap for game information.

System Requirements: Macintosh Plus, SE, portable, LC, or II Series
computer; hard disk; System software version 6.0.2 or later; and fully
compatible with System 7.

PRIMA PUBLISHING


